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Annotatsiya. Ushbu maqolada astronomiya kursining laboratoriya mashg‘ulotlarida 

koinotning katta o‘lchamli tuzilishini o‘qitish metodikasi ishlab chiqilgan. 

Kalit so‘zlar: koinot, galaktika, astronomiya, megagalaktika, Andromeda, yorqinlik, 

vireo, Habbl qonuni, laboratoriya, yulduz, kvazar.   

ПРЕПОДАВАНИЕ ПРЕДМЕТА «КРУПНОМАСШТАБНАЯ СТРУКТУРА 

ВСЕЛЕННОЙ» НА ЛАБОРАТОРНЫХ ЗАНЯТИЯХ КУРСА АСТРОНОМИИ 

Аннотация. В данной статье разработана методика обучения 

крупномасштабному строению Вселенной на лабораторных занятиях курса астрономии. 
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TEACHING THE SUBJECT "LARGE-SCALE STRUCTURE OF THE UNIVERSE" IN 

THE LABORATORY LESSONS OF THE COURSE OF ASTRONOMY 

Abstract. This article has developed a methodology for teaching the large-scale structure 

of the Universe in the laboratory classes of the astronomy course. 
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Koinotning bizga ko„rinadigan qismi Metagalaktika deb ataladi. Metagalaktika 

milliardlab galaktikalar, kvazarlardan tarkib topgan. Hozirgi zamon kuzatish vositalari 

yordamida qayd qilingan eng uzoq ob‟ekt (kvazar) larning masofasi Metagalaktikaning radiusi 

deb qabul qilingan va u 4000 Mpk (megaparsek)dan biroz ko„proq. Bu o„lcham Xabbl qonuniga 

galaktikalarni qochish tezligi o„rniga kvazarlar tezligi (270000 km/s)ni va Xabbl doimiysi H=73 

km/sMps qiymati asosida topilgan. Metagalaktikadagi ob‟ektlar har xil yo„nalishlar va 

masofalar bo„yicha o„rtacha olganda bir tekis joylashganlar. O„rtacha bir jinsli deganda biz 

Metagalaktikani katta o„lchamli (1000 Mpk) tuzilishni nazarda tutmoqdamiz. Yuqorida 

ko„rganimizdek kichik o„lchamli (100 Mpk) qismlarida Metagalaktika bir jinsli emas, unda 

galaktikalar guruhlari, to„dalari, o„ta katta to„dalar kuzatiladi. Metagalaktikani katta 

o„lchamlarda bir jinsliligi undan tashqarida ham o„rinli bo„lsa kerak deb faraz qilish mumkin. 

Shunday qilib butun Koinot (ya‟ni Metagalaktika va undan tashqaridagi koinot qismi) da 

materiya izotrop va bir jinsli taqsimlangan deb qarash mumkin. 

Har xil uzoqlikda joylashgan Koinot ob‟ektlaridan kelayotgan va qayd qilinayotgan 

nurlanish ulardan har xil vaqtlarda sochilgan. Yorug„likning tarqalishi tezligi fundamental fizik 

doimiyligini hisobga olsak uzoqda joylashgan kvazarlardan kelayotgan nurlanish yaqindagi 

galaktika (Andromeda tumanligi) dan kelayotganlarga qaraganda ancha (10 mld. yil) oldin 

sochilgan (yo„lga chiqqan). Metagalaktikada uzoqlik bo„yicha ob‟yektlar (galaktikalar)ni 

taqsimlanishidagi bir jinslilik ular hosil bo„lish vaqti bo„yicha uzluksiz ketma-ketlikni hosil 

qiladi degan xulosaga olib keladi. 
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Galaktikalar va kvazarlar spektrida chiziqlarni qizilga siljishi ularni bizdan uzoqlashish 

bilan tushuntiriladi. Ob‟yekt bizdan qancha uzoqda bo„lsa uni uzoqlashish tezligi shuncha katta. 

Metagalaktika kengaymoqda, kengayish tezligi Xabbl qonuni      bilan ifodalanadi. 

Metagalaktikani tashqi chegarasi yaqinida kengayish tezligi yorug„lik tezligiga yaqinlashadi. 

Agar bu qonuniyat Metagalaktikadan tashqarida ham o„rinli deb hisoblasak u holda bir jinsli 

butun Koinot hozirda kengaymoqda. Demak u o„tgan zamonlarda hozirgiga qaraganda zichroq 

va qaynoqroq bo„lgan va uzoq o„tmish (10 mld. yil oldin) esa zichlik va temperatura juda yuqori 

bo„lgan. Metagalaktikada kuzatilayotgan ob‟ektlar va jarayonlar butun olamni tortishish qonuni 

(umumiy nisbiylik nazariyasi)ga bo„ysunadi. Bu qonunni uzoq o„tmishdagi o„ta yuqori zichlik 

(10
93

g/m
3
) va temperaturadagi (10

32
 K) Koinotga tadbiq etib bo„ladimi, yo„qmi bu muammo 

bo„lib qolmoqda. 

Ishni bajarish tartibi 

Kompyuterga VIREO dasturi o„rnatiladi va dastur ishga tushiriladi. VIREO dasturi (I) 

ishchi oynasi ochilgach, uning tepa chap chetida «File» yozuvi ustiga Kursorni qo„yib bir marta 

bosing, hosil bo‟lgan ustundan «Login» ni bosing (1-rasm, tepa chapda). Ishchi oynada 

«Student Accounting» sahifasi ochiladi (1-rasm, o„ngda). 

 
1-rasm. 

 Unga talabalarning ismini va laboratoriya ishi raqamini (Laboratory Table Number:) 

kiriting va «Ok» ni bosing, yangi sahifa chiqadi, unda tepa chap chetidagi «File» yozuvi ustiga 

kursorni qo„yib bir marta bosing, hosil bo‟lgan ustundan «Run Exercise…» yozuvi ustiga 

kursorni to„g„irlang, hosil bo„lgan ustundan «The Large Scale Structure of The Universe» 

nomli yozuv ustiga kursorni bir marta bosib yangi sahifani ochamiz (1-rasm, pastda).  
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TELESKOPNI ISHGA TUSHIRISH 

Yangi ochilgan (II) sahifa tepasidan «Telescopes» yozuvi ustiga kusrsorni to‟g‟irlab bir 

marta bosing, unda “Optical” yozuvi hosil bo‟ladi. Kursorni “Optical” yozuvi ustiga qo‟ying va 

hosil bo‟lgan ustunda “Access 4 Meter” bosing (bu amalni bajarishda 1 m yoki 4 m li 

telskopdan foydalaniladi). Endi “Open” tugmasini bosing, observatoriya oynasi ochilgach “off” 

tugmasini bosib teleskop (III) sahifasi ochiladi. Osmon sahnida yoritkichlar va qizil kvadrat bor, 

e‟tibor bersangiz yoritkichlar chapdan o„ngga tomon siljimoqda, bu osmonning qo„zg„almas 

teleskopga nisbatan sutkaviy aylanishidir, bu harakatni to„xtatish uchun «Tracking» ni bosing. 

Endigi qiladingan ishimiz kerakli obyektlarni tanlash bo‟ladi. Buning uchun “Slew” menyusidan 

“Observation Hot List”  “Load Hot List…” amalni bajarib “Select LSS Field” oynasi 

ochiladi va ro‟yhatdan “Survey Field 1” ustiga kursor bilan tez-tez ikki marta bosing (bunda 

birinchi maydon obyektlari ro‟yhati ochiladi) (2-rasm, tepa chapda), keyin “Slew” menyusidan 

“Observation Hot List”  “View/Select ….” Amalini bajarib galaktikalar ro„yxatini ochamiz 

(2-rasm, tepa o‟ngda). Ochilgan ro„yxatdan birinchi galaktika ustiga Kursorni ketma-ket ikki 

marta bosilsa galaktika koordinatalari chiqadi (2-rasm, past chapda), “OK” tugmasini bosib 

teleskopni bu ob‟yektga to„g„irlaymiz. Teleskop kerakli ob‟yektga to‟g‟irlangandan keyin 

“View” ustunidan “Telescops” yozuviga bosing. 

 
2-rasm 

Kuzatuv oynasi o„rtasida ikkita parallel qizil kesmachalar paydo bo„ladi (2-rasm, past o„ngda). 

Agar parallel qizil chiziqlar galaktikani ustida bo‟lmasa N, S, E, W tugmalar yordamida 

tanlangan galaktikani tirqish ichiga joylashtiramiz. 

SPEKTROMETR YORDAMIDA GALAKTIKA SPETRINI ANIQLASH 

Galaktika spetrini aniqlash uchun “Telekop boshqaruv paneli (II sahifa)” dan  “Instrument” 

ustuni pastidagi «Access» nomli tugmani bosamiz va “VIREO Reticon spectrometer Reading” 

nomli yangi (IV) sahifa ochiladi. Sahifa o„rtasida koordinata o„qlari belgilangan grafik chizish 

uchun tayyor chizma joylashtirilgan. Endi «Go» tugmasining ustiga kursorni qo„yib bosing. 

Chizma ichida spektrometr qabul qilayotgan fotonlar orqali galaktika spektri shakillana 

boshlaydi. Fotodiodlar tushayotgan fotonlar oqimi o„zgaruvchan bo„lganligi uchun qancha uzoq 

vaqt davomida foton sanalsa har bir fotodiodga tushayotgan fotonlar yig„indisi shu to„lqin 
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uzunlikda kelayotgan oqimning haqiqiy qiymatiga yaqinlasha boradi, spektrning yozuvi silliq 

egri chiziqga aylanaboshlaydi. Chizmadan pastda galaktikaning belgisi «Object» to„g„risida, 

ko„rinma kattaligi «App. Mag (V)» ko„rinib turadi. Foton yig„ish vaqti «Integration» 

(sekundlarda), o„rtacha har bir fotodiodda to„plangan fotonlar soni «Photons per Channel» va 

signal/shovqin nisbati «Signal/Noise» to„g„risida yozila boshlaydi (3-rasm, chapda). 

 
3-rasm. 

 «Signal/Noise» nisbati 100 dan ortishini kutib, foton sanashni davom ettiramiz. Bu nisbat 

1000 ga yaqinlashganda spektr juda yuqori sifatli bo„lib chiqadi. «Signal/Noise» nisbat 100 dan 

oshgandan keyin «Stop» ni bosish mumkin. Shunda sanash to„xtaydi va o„lchash natijalarini 

kompyuter xotirasiga yozib qo„yish kerak, buning uchun sahifa tepasidagi “File” ga kirib 

“Data” yozuvi ustiga kusorni to‟g‟irlang, hosilbo‟gan ustundan  «Save Spectrum» ni bosing. 

Bunda olingan spektr boshida talaba nomiga ochilgan papka ichiga obyekt nomi (...CSP) bilan 

saqlandi (3-rasm, o„ngda). Endi uchinchi (III) sahifaga qaytamiz va har bir maydondagi 

galaktikalarning spektrini aniqlab olamiz. 

GALAKTIKALAR SPEKTRINING QIZILGA SILJISHI ANIQLASH 

Galaktikalar spektridagi qizilga siljishni aniqlash uchun osmon sahnini berkitib (I) asosiy 

sahifaga qaytamiz. Bu sahifaning chap yuqori qismidagi “Tools” → “Spectrum Measuring” 

dan “VIREO Spectrum Measuring Engine” koordinata sistemasi ochiladi. Sahifaning chap 

yuqori burchagidagi “File”→“Data”→“Load Saved Spektrum” amali bajariladi. Bunda 

yuqorida saqlangan spektrlar papka ko‟rsatiladi. Ulardan ketma-ketlikda tanlab ochamiz (4-

rasm). 

 
4-rasm 
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Koordinatalar sistemasi ichida biz tanlagan spetr chiqadi. Bu sahifada “Comparision 

Spectrum” → “Select” amalini bajarish orqali  “Line for Z Measurement” sahifasi ochiladi (5-

rasm, tepa chapda). Bu sahifadan “Absorbtion Line in normal galactics (H, K, and G band)” 

ustiga Kursor bilan tez-tez ikki marta bosish orqali ochilgan galktika spektrida H, K va G 

chiziqlarining o‟rnini ko‟rsatuvchi vertikal chiziqlar paydo bo‟ladi (5-rasm, tepa o‟ngda). 

 
5-rasm 

O„lchash natijalari o„rtachalanib, egri chiziq bilan tutashtiriladi va spektrni yozuvi hosil bo„ladi. 

Bu yozuvda qora chiziqlar intensivlikni keskin pasayib va yana keskin ko„tarilishi sifatida 

namoyon bo„ladi va galaktika tutash spektrida chuqurcha shakliga ega bo„lgan K(CaII) 3933,7 

A
o
, H(CaII) 3968,5 A

o
 va G(metall tasma 4305 A

o
) yutilish chiziqlari ko„ranadi. H, K va G 

chiziqlarini eng intensivligi pas bo‟lgan chuqurchalarga to‟g‟irlash uchun pastdagi suriluvchi 

tugma yordamida o‟ngga tomon surib to‟g‟irlanadi (5-rasm, past chapda). Agar surish tugmasi 

o‟ng chegaraga yetsa, biroq vertikal chiziqlar spektral chiziqlar o‟rtasiga tushmasa, surish 

tugmasi ustidagi katakdagi tugmani “Coarse” ga qo‟yish orqali muammoni hal qilsa bo‟ladi. 

Vertikal chiziqlar spektral chiziqning qoq o‟rtasida bo‟lgan holga mos keladigan “Z” suriluvchi 

tugma yacheykasiga yozib olinadi (5-rasm, past o‟ngda). Bu yozuv butun va kasr qismdan iborat, 

uning o‟ng tomonida yozuvdagi sonni yana o‟n darajasi minus songa ko‟paytirish zarur.  

Keyingi qiladigan ishimiz har bir spektral chiziq (H, K, G) uchun to‟lqin uzunligini yozib 

olishdir. Buning uchun vertikal chiziqlar ustiga kursorni to‟g‟rilab bir marta bosilganda qizil 

chiziq oq rangga o‟tadi, shu holatdagi “wavelength” yacheykasidagi son qiymat shu spektr 

to‟lqin uzunligini bildiradi va yozib olinadi. 

 Aniqlangan qizilga siljish qiymatidan foydalanib galaktikalaning nuriy tezligi topiladi. 

Endigi qiladigan ish, “File”→“Data”→“Record Measurements…” amalini bajarib olingan 

natijani saqlash bo‟ladi. Saqlash vaqtida “Measured Redshift…” sahifasi opchiladi. Bu sahifada 

“Velocity” (tezlik) yachaykasiga yuqorida topilgan nuriy tezlik qiymatini yozamiz va “Ok” 
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tugmasini bosib natijani saqlaymiz. Har bir galaktika spektridan yuqoridagi amallarni bajarib 

qizilga siljishni va tezlik qiymatlarini topib savlash amallarini bajaramiz.  

 
6-rasm 

KOINOTNING KATTA O„LCHAMLI TUZILISHI 

Galaktikalar spektrida chiziqlar K(CaII) 3933,7 A
o
, H(CaII) 3968,5 A

o
 va G(metall 

chiziqlari) 4305 A
o
 ni siljishidan topilgan, ularning uzoqligi va o‟lchangan koordinatalari (α va 

δ) ga asosan ularni fazoda joylashishi o‟rgniladi. 

Galaktikalar spektrida chiziqlar to‟lqin uzunligi (λ) o‟lchangandan keyin bu chiziqlarning 

qizilga siljishi (       ,   - qo‟zg‟almas manba spektrida chiziqning to‟lqin uzunligi) va 

unga asoslanib galaktikaning nuriy tezligi   
  

  
  hisoblanadi. Maydonlardagi barcha 

galaktikalarning tezligi o‟lchangach (α, δ, υ) diagrammasi tuziladi(7-rasm). Diagrammani tuzish 

uchun olindin har bir spektrdagi tezliklar yuqorida aytilganiday saqlangan bo‟lishi kerak. Endi 

saqlangan natijalar asosida asosiy sahifa(The Large Scale Structure of The Universe)ga 

qaytamiz va “Tools” → “LSS Wedge Plot” amalini bajaramiz. Sizda kerakli diagramma hosil 

bo‟ladi. Bu diagrammada siz spektrini o‟rganish orqali topgan tezlik va koordinatalar 

bo‟g‟lanishi kelib chiqadi. Bu galaktikalarning Koinotdagi taqsimotini ko‟lsatadi. “File” → 

“Print Wedge Plot…” amalini bajarish orqali diagrammani saqlash yoki printerdan chiqarish 

mumkin. 

 
7-rasm 
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Vazifa 

1. Berilgan maydonlardagi galaktikalarning spetrini oling va har bir chiziq uchun ularning to‟lqin 

uzunliklari, qiziliga siljish va nuriy tezliklarini aniqlang. 

2. Yuqoridagi ma‟lumotlardan foydalanib Koinotning katta o‟lchamli strukturasi diagrammasini 

tuzing. 
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